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Graphing in Excel 
featuring Excel 2003
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A spreadsheet can be a powerful tool for analyzing and graphing data, but it works completely differently from 

the graphing calculator that you’re used to. If you’ve used a spreadsheet before, you may think of it as only being 

able to graph individual data points, but it’s actually pretty easy to get it to graph lots of ordinary functions, too. It 

is at its most powerful in graphing when those features are used together. This document will show you how to 

get a scatter plot of a set of data and how to graph a function with that data (a model of the data) to see how well it 

fits. 

The first thing we’ll need is some numbers. I’m going to use the set of times and drug concentration levels in a 

patient’s bloodstream given below. 

Time (h) 0.5 1 1.5 2 2.5 3 3.5 4 4.5 5 5.5 6 6.5 7 7.5 8 8.5 9 9.5 10 

Drug (µg) 9 8.3 7.8 7.2 6.7 6 5.3 5 4.6 4.4 4 3.7 3.2 2.8 2.5 2.5 2.1 1.9 1.7 1.5 

  

The first row will give the x-coordinate, and the second will give the corresponding y-coordinate. So it’s time to 

put the data into a spreadsheet. 

 

Open Excel. You should get a big blank page full of empty cells, and some tools along the 

top. Pick a cell somewhere in the top left area of the spreadsheet (which doesn’t have to be 

A1, if you’d like some space on the outside), and begin entering the information. It’s most 

natural to enter each row above as a column instead. Type the column heading, hit Enter, 

and you’ll be on the next row ready to type the first data value. When you’ve finished with 

the first column, start at the top again and enter the second one. Once you’re done, you 

should have something like you see at right. 

 

The “µ” symbol is a lowercase Greek “mu,” and it represents the metric prefix “micro" here. 

You can get it by using the Insert Symbol command, which in Excel 2003 is located in the 

Insert menu. 

 

Once you’ve entered the data, it’s time to tell the program to 

make a graph for you. Excel will step you through the basic 

process, and you can change whatever parameters (a/k/a 

“settings”) you’d like to afterwards. So select the data, 

including the headings, and go on to the next page.

                                                           
1
 These instructions are more or less the same for any ordinary spreadsheet program, although the locations of the commands 

may be different. On the same site where you found this document, you should also find a second one featuring Excel 2007. 

It uses screenshots from that version of the program, but is designed to help you produce the same results. 
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With your data selected, go to the Insert menu. Choose Chart… and you’ll be presented with 

the Chart Wizard, which will step you through the process. 

 

We’re going to choose a scatter plot, 

which is by far the most traditionally 

mathematical of the available types. If you’ll be graphing a 

function like you would on a calculator, the scatter plot is 

definitely where you want to start. 

 

When you click on Scatter in the Chart type list, you’ll see 

several versions of the 

scatter plot on the right 

side. The one we want is 

the ordinary one in the 

top left, just a bunch of 

discrete points. 

 

There’s a nifty little 

feature at the bottom of that window. It’s a button labeled “Press and Hold to 

View Sample.” If you do what it says, you’ll see how your graph will look if you do nothing else to it. If you’re 

happy with that, click finish at the bottom, and you’ll have your scatter plot. 

 

However, the default doesn’t have any indication as to what the values on the x-axis mean, neither of the axes is 

labeled (although there is a scale), and the title is just whatever was at the top of the y-column. We can do better. 

In addition, this version of Excel defaults to a gray background, which is really not the best for printing in most 

cases. So we’re going to make some changes. The Next button at the bottom will take us to the options. 

 

The Data Range is exactly what you selected before 

asking the program for a chart, so it ought to be just fine. 

The other tab, Series, should also be correct for exactly 

the same reason. Later on, though, when we want to add a 

curve to the graph, the Add button there can be very 

useful. Next. 

 

The Chart Options step is where we’ll fine-tune things, 

starting with the title and axis labels. Initially the title is 

that y-column heading, but I’ll expand on it and type in 

some 

appropriate 

things for the 

axis labels. 
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As I enter these things and tab to the next field, the picture of the chart updates to show the changes. Here’s what 

I’ve got now. I like it a little better in some ways, but it’s still pretty awkward. The next step is the Gridlines tab at 

the top of the screen. The Axes tab (which you may certainly choose to look at) only turns the axes on or off, and 

I want them both turned on, just like they are now. 

 
 

Here’s what you see when you choose Gridlines. I’m fine with the way the vertical axis looks, but I’d like 

gridlines to go up from the x-axis as well, so I’ll check the major gridlines box for the “Value (X) axis” and move 

on to the Legend tab. 

 

 

Since I only have one series here, I don’t need a legend to indicate 

what different things on the graph represent. So I’m turning it off by 

unchecking “Show legend.” I think that looks a lot better already. You 

might notice that the upper bound on the x-axis has changed and the 

vertical gridlines are now spaced at 2 units rather than 5. That’s an 

automatic adjustment the program makes. I have no idea how it makes 

its choices. Luckily, you can set those things yourself if you’d like. 
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The Data Label tab is for putting values next to the points. It is occasionally useful, but not with as many points as 

you see here, so skip it, and choose Next. 

 

That’s pretty much it as far as choices. I 

always put my chart in the current worksheet 

so it’s “on the same page” as the data I’m 

working with. When I choose that, and 

Finish, here’s what I get. 

  

I still want to clean that up, though, 

particularly the gray background and the x-

scale. When you click on the chart itself in 

Excel 2003, you get a small window called 

Chart that lets you make changes. You can 

also use the Chart menu at the top of the 

screen. I never seem to find everything I 

want in the same place; that might be me, or maybe not everything is in both places. The little window is handy, 

though. The place where this one says Chart Area on the left side is a pop-up menu. You choose what part of the 

chart you’d like to change, then make the changes. You can also change what appears there by clicking on 

something in the chart itself, but I find that I don’t 

always click on what the program thinks I should 

have, which slows the process down. 

 

As you choose different things from this pop-up, watch how the selection changes. I can tell pretty quickly that 

the gray part is called Plot Area. I want to fix that. If you hover your cursor over the little icon to the right of the 

menu, you’ll see that it will let you format the plot area. Click it. 

 

There are not a lot of choices here – only one tab. But it’s 

exactly what I want. I’m going to change the Area to None, 

and the gray shading should disappear. See? 
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On to the axes. I’ll start with the x-axis: . When I choose to format that, I get a lot 

more options, five tabs worth. 

 

I know that what I want here is to change the scale, so that’s where 

I’ll go. Everything is initially set to automatic. I don’t like the 

unpredictability or the fact that there’s a useless part of the domain 

showing (beyond 10 hours), so I’ll change a couple of things. At 

right are the settings I picked. I wanted to make sure the minimum remains at 0, 

and I changed both the maximum and the major unit. I’m not going to turn on 

the minor unit, so I don’t care about that. I do want the axes to cross at (0, 0) – 

it is math class, after all – but I don’t think that’s going to shift around on me. If 

I find that it does, I’ll set that explicitly rather than letting it be automatic, too. 

 

After choosing OK, I’m looking at the chart below. If all you really need is a 

scatterplot of your data, you’re done. Up to this point, I’ve been taking 

screenshots rather than copying the actual graph. Screenshots are only good up 

to the resolution of the screen,
2
 but the actual copy of the entire chart below 

ought to print well up to the resolution of the printer when it’s in a word processing document. You just click 

somewhere in the graph’s bounding box, Copy, move to the word processing file, and Paste. You can resize it 

here if you want it to fill the space better. I’ve made mine the width of the text. To keep the proportions the same 

as you resize the graph, be sure to do it by using one of the corner handles, not one of the edges. Here it is.  
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2
 Hence the name. 
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Pretty much anyone who works with spreadsheets at all can do something like this. It’s a really useful way to see 

trends over time. However, in mathematics, we generally want to model the pattern with some sort of formula. I 

have used a regression on my graphing calculator to come up with the function A(t) = 10.484 · (0.82942)
t
 for this 

one.
3
 I would like to graph that function along with these points to see how well it fits. 

 

As you’ve seen so far, spreadsheets deal with discrete data points, and they don’t really do curves that aren’t just 

connecting those dots. However, that’s precisely what a graphing calculator does. In this case, we have to tell the 

spreadsheet what x-values to use, have it find the corresponding y-values, and connect those points with a nice 

smooth curve. 

 

I would like my function to graph on the interval [0, 10], and I want plenty of points to connect to ensure that I get 

a good shape. I’m going to make a table counting from 0 to 10 by 0.1. Here’s how. On your spreadsheet, pick a 

new place to enter data, perhaps below the original data, perhaps beside the chart, whatever works for you. It is 

helpful to be able to see the chart with at least the beginning of the data. Enter column headings: t and A(t). Then 

in the cell underneath t, type the first value, 0. 

 

Select the cell containing 0, and then go to the Edit menu, down to 

the Fill menu choice, and choose “Series…”. This is a brilliant little 

tool that lets you count by whatever you’d like for as long as you 

want. I’ve decided to count by 0.1 until I get to 10. You can see how 

I’ve entered that. Note that I told the program that I want the series 

in columns. If I had left it as rows, it would have gone to the right 

instead of down. Click OK, and you have a really nice list of values 

of t to use in finding the values of A(t) that we’d like to graph. 

 

 

 

 

 

 

 

 

 

To get Excel to calculate those values, you’ll enter the function as an Excel formula in the cell adjacent to 0, and 

then Fill Down to get it in the rest of the cells. Be sure to choose Columns to get the values to go down rather than 

across. 

 

The formula starts with your typing an = sign. That’s how Excel knows it’s 

supposed to calculate something rather than just displaying it. The syntax is 

just like that for a calculator, as you can see. The one peculiarity is S5. Why S5 

instead of t? Because that’s where the value I want plugged in is located. See?  

 

                                                           
3
 If you need to know how to find such a function with a regression, there’s another tutorial on this site for just that purpose. 

Actually, there are two: one for the TI-84/83 series calculator, and another for the TI-89. 
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I didn’t actually type S5. I got it by clicking on the cell I wanted when I got to that point in the formula. After I 

typed Enter, I got the value you see to the right of that cell. To get the rest of the A(t) values, select that first cell 

(T5 in my case), and drag a selection down all the way to the bottom of the table of values, so that the last 

selected cell is next to t = 10. Now go back to the Edit menu for Fill again, and this time just choose Down. Excel 

will copy the formula into each of those cells, but will update the cell that’s referred to each time. In the second 

row, it will say S6, then S7, and so on, so that each value in the right column is calculated from the one 

immediately to its left. It’s a big table like your calculator would make. 

Before Fill Down:  After Fill Down:  

 

 

This big list of points is what I’m going to graph with my original curve. Getting them on there in the first place 

requires adding data to the chart we already created. Then it takes a couple of adjustments to make the graph look 

like something other than a big mass of dots. 

 

Click on the chart again, and this time 

go up to the Chart menu at the top of 

the screen and choose Source Data…. 

Select the Series tab. Remember this 

screen? We’ll be adding another 

series, so in the resulting dialog box, 

click Add. 

 

 

  

 

While it’s possible to type a whole bunch of stuff into the Edit 

Series box, you can also select things by dragging, and that’s 

generally simpler. 

The way you do 

this is to put your cursor in the appropriate box and click the little 

icon with the tiny arrow next to the right the appropriate box 

 

 

 

When you do that, the box shrinks up to something like the 

one seen at right. Don’t panic, the large one will come back. 

Use your cursor to select the cells you need. For Series name, 

I selected the cell that said A(t). Then I clicked that little tiny arrow button on the right of the reduced box, and 

got right back to the previous Edit Series view. I did the same thing for Series X values, this time dragging all the 

way from 0 to 10 down my table of data. And when you get ready to select the Series Y values, delete the “={1}” 

that you see here if it shows up for you. After all of that selecting, you should have something like this: 
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Click OK and watch the crazy square dots appear. There are two reasons why this is not so great. The first, and 

most obvious, is that it obscures almost all of the 

original data points. The second, and at least as 

important is that what I’d like to see is the function 

A(t), not a big collection of dots of any size. 

 

We’re going to change the way the second series of 

points is displayed, so that the dots are not shown, 

but a smooth curve
4
 connecting them is. 

 

Click on the chart, and from the little Chart box that 

shows up, select the brand new menu item ‘Series 

“A(t)”’ at the bottom of the list. Then click the 

Format Data Series button directly to the right of the pop-up menu. This is where we’ll do the fixing. 

 

First is to remove the big squares. In the Pattern tab, under Marker, select None. Then 

on the Line side of the same tab, choose Automatic and Smoothed line. This makes it a 

curve rather than a bunch of little segments. If you don’t like the weight of the line, 

you can change that here, too. Click OK to get out of there. You’re almost done. 

 

 

 

 

 

 The very last thing that this graph needs is a 

legend. You may be asking why, since I 

specifically removed the legend when I made 

the scatter plot at the very beginning. The 

answer is that now there are two things graphed, 

and the reader needs to know which is which 

without having to look it up in the text or 

compare it to an earlier graph. 

 

To add the legend, once again select the chart, and from the Chart menu at the top of 

the screen, choose Chart Options. On the Legend tab, check Show Legend. You get 

several choices of where to put it, and you can choose what seems most legible to 

you. I don’t always choose the same thing. And finally my finished graph appears on 

the next page, including both the scatter plot and the regression line. 

 

When I looked closely at it at this size, I discovered I don’t particularly like the wobbly nature of parts of the 

curve. This is one place where the 2007 version of the software does a better job. However, you can improve it 

somewhat by making the points you plot 0.01 apart rather than 0.1. The program doesn’t care, and it fills in the 

series just as quickly for 1000 points as for 100. When I did that, I got the second graph on that page. Still not 

perfectly smooth, but plenty good enough to get the point across and let you compare the curve to the data set. 

                                                           
4
 Um, smoother. You’ll see what I mean at the end. 
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That’s it. I did this rather quickly, so let me know if you find any typos or if I appear to have left out any steps. 


